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COPYRIGHT
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Corporation's liability for actual damages from any cause 
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THIRD-PARTY COPYRIGHTS

This product includes software developed and copyrighted by the 
following persons or groups:
Apache Software Foundation (http://www.Apache.org)
Copyright © 1999 The Apache Software Foundation. All rights 
reserved.
THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
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LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
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About BindView Corporation
About BindView 
Corporation

BindView Corporation is a leading provider of proactive business 
policy, IT security and directory management software worldwide. 
BindView solutions and services enable customers to centralize and 
automate policy compliance, vulnerability management, directory 
administration and migration across the entire organization. With 
BindView insight at work™, customers benefit from reduced risk and 
improved operational efficiencies with a verifiable return on 
investment. More than 20 million licenses have shipped to 5,000 
companies worldwide, spanning all major business segments and 
the public sector.

Online Documents Documentation is provided in the following electronic formats on the 
BindView product CD:

• Adobe® Acrobat® PDF files
• HTML Release Notes files
• Online help

Using PDF Files With Adobe Acrobat PDF files, you can navigate through a document 
quickly and perform full-text searches. In addition, the PDF files can 
be viewed online, distributed to multiple users electronically, or 
printed.

You must have Adobe® Reader® installed to read the PDF files.

To view PDF files, double-click PDF files to open them, and then 
move through the document by clicking topic headings in the left 
pane or green hypertext links in the text. To print copies, click Print 
from the File menu.

Installing Adobe Reader Adobe Reader installation programs for common operating systems 
are available for a free download from the Adobe Web site at 
www.adobe.com.

User Guides The Docs directory on the BindView product CD contains copies of 
the user guides and other documentation in the PDF format. 

The BindView RMS Web Console User Guide contains information 
about the BindView RMS Wehb Console v8.00 If you upgrade the 
BindView RMS Console and Information Server, the BindView RMS 
Console and Information Server User Guide and the BindView RMS 
Web Console User Guide included with the update will contain 
information about the new version of the Console.
12 BindView RMS Web Console User Guide

© 2004 BindView Corporation. All Rights Reserved



Release Notes
Release Notes If the autorun function is enabled, a Readme HTML file for your 
BindView product is accessible under the Documentation menu of 
the BindView setup menu when you insert your CD. You also can 
select to view this file after the installation is completed, or by 
browsing to the Release Notes directory in the root directory for 
your program:

C:\Program Files\BindView\RMS\Release Notes

Online Help Comprehensive help is available from the Help menu on the 
BindView RMS Console and the BindView RMS Web Console. 
Additionally, you can access help by clicking the Help button in any 
dialog, by right-clicking an item and selecting Help from the action 
menu, or by pressing F1 in any dialog.

Typestyle 
Conventions

The following conventions are observed throughout this guide:

• Bold text is used to designate file and folder names, dialog titles, 
names of buttons, icons, and menus, and terms that are objects 
of a user selection. 

• Italic text is used for word emphasis, defined terms, and manual 
titles.

• Monospace text (Courier) is used to show literal text as you 
would enter it, or as it would appear onscreen.

Alert Statements The alerting statements are Notes, Cautions, and Warnings. These 
statements are formatted in the following style:

Note: Information that is incidental to the main text flow, or to an 
important point or tip provided in addition to the previous 
statement or instruction.

Caution: Advises of machine or data error that could occur should 
the user fail to take or avoid a specified action.

Warning: Requires immediate action by the user to prevent actual 
loss of data or where an action is irreversible, or when physical 
damage to the machine or devices is possible.
Information Resources 13
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Contacting BindView
Contacting 
BindView

BindView has sales and support offices around the world. For 
information on contacting BindView, please refer to the information 
below or to the BindView Web site: www.bindview.com

For Technical Support: www.bindview.com/support

Technical Support is available Monday through Friday from 
7:00 a.m. to 7:00 p.m. Central Time. Normal working hours for all 
other departments are 9:00 a.m. to 6:00 p.m.

Phone

Sales and Customer 
Service

U.S. and Canada 800-813-5869

Outside N. America 713-561-4000

Technical Support U.S. and Canada 800-813-5867

Outside N. America 713-561-4000

Training/Professional 
Service

U.S. and Canada 800-749-8439

Outside N. America 713-561-4000

Fax All Areas 713-561-1000

E-mail

Sales sales@bindview.com

Training edu@bindview.com

Documentation docs@bindview.com

Other

FTP Site ftp://ftp.bindview.com

Internet www.bindview.com

Postal Mail BindView
5151 San Felipe, Suite 2500

Houston, TX 77056
14 BindView RMS Web Console User Guide
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BindView RMS Suite
BindView RMS 
Suite

The BindView RMS® suite helps you secure your enterprise and 
simplify the management and administration of network operating 
systems, directories, and related applications. The BindView RMS 
suite consists of the following products:

• BindView RMS Console and Information Server
• BindView RMS Web Console
• BindView RMS Decision Support Center
• bv-Control® products

The BindView RMS Console and Information Server are the principal 
components of the BindView RMS product family infrastructure. The 
BindView RMS Console (Console) is the primary user interface for 
bv-Control products. The BindView RMS Console provides query, 
ActiveAdmin®, baseline, task list, chart, report, and export 
features. The Information Server is the primary component for all 
BindView RMS product task processing and data storage.

The BindView RMS Web Console (Web Console) is a Web-based user 
interface that provides query, baseline, scope manager, task status 
monitoring, enterprise browser, and real-time monitoring services. 

The BindView RMS Decision Support Center provides threshold-
based notification and automated actions for pre-defined conditions 
that threaten the integrity of your business enterprise.

The bv-Control products allow you to query, manage, and 
administer specific areas of your enterprise.
16 BindView RMS Web Console User Guide
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BindView RMS Web Console
BindView RMS 
Web Console 

With proper installation and configuration, BindView RMS Web 
Console offers the following features that allow you to gather and 
view information about your network.

• Offers high security using SSL data encryption.
• Enables users to build queries and launch existing query binders 

and task lists.
• Enables users to browse query binders and view historical 

datasets.
• Enables users to view dataset reports exported from the Console.
• Enables users to view the status of queries, baselines, and task 

lists that are currently processing.
• Enables users to connect to an EDBS using the same Web server.
• Refreshes to list new alerts that have been created.
• Enables you to filter events by date, severity, acknowledgment 

status, and machine name for listing alerts.
• Enables users with admin privileges to view alert details, and to 

acknowledge and unacknowledge multiple alerts.
• Enables users with admin privileges to start or stop scripts.
• Enables users to browse through a list of products that publish 

information in the Enterprise Browser.
• Enables users to baseline any two historical datasets that are 

linked to a query binder.
• Enables users to create, modify and delete named scopes, as well 

as define default scopes.

BindView RMS 
Web Console 
Architecture

BindView RMS Web Console consists of three major components: 
BindView Information Server, Event Database Server (EDBS), and 
Microsoft Internet Information Server (IIS), as shown in Fig. 1.

Fig. 1 BindView RMS Web Console Architecture

Web BrowserWeb Browser

Information ServerEDBS

Internet Intranet
IIS

IntranetIntranet

Internet Explorer 5.0
or Netscape 4.7.2
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Selecting a BindView Information Server
Selecting a 
BindView 
Information 
Server

The logon window is the initial window that appears once you have 
launched the Web Console. It allows you to select the desired 
Information Server to be used when opening the Web Console. 

To connect to the BindView RMS Web Console, use the address 
http://<machine name>/RMS in Internet Explorer or Netscape 
Navigator, where <machine name> is the name or IP address of 
the BindView RMS Web Console machine. In order to use the 
BindView RMS Web Console, you must have cookies enabled in your 
web browser. 

Fig. 2 Select BindView Information Server Window

The fields and buttons available on the window are:

• Machine Name – Displays the Information Server computer that 
you previously selected from the Machines list box. 
- Browse (...) – Displays the Domains and the Machines list 

boxes to allow you to make a selection. Once you make your 
selection and click Select, both list boxes and the Select and 
Close buttons will disappear.

- Located on web server machine – This check box will only 
appear if you have both the IIS and the Web Gateway Service 
installed on the same machine. By clearing this check box, the 
Browse button will be enabled so that you can select a domain 
and a machine from the corresponding pick lists. 
When using a BindView Information Server located on the same 
machine as the Web server, this box must be checked. 
18 BindView RMS Web Console User Guide
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Using the BindView RMS Web Console
• User Name – Requires you to enter a valid User Name with 
administrative rights to connect to the selected Information 
Server. The user name should be in the form of domain\user 
name or machine\user name if the machine selected is a 
workgroup.

• Password – Requires you to enter the password associated with 
the user name you entered.

• Remember the machine and user names – Allows you to save 
the Machine and the User Name entered when you select the 
check box.

• Connect – Allows you to connect to the selected Information 
Server.

When you click the browse (...) button, these items appear. 

• Domains – Allows you to select the domain the Information 
Server belongs to.

• Machines – Allows you to select a specific Information Server 
computer from the list box.

• Close – Closes the Domains and the Machines selection boxes.
• Select – Acknowledges your selection from the list boxes. When 

you click this button, the information selected will be placed into 
the appropriate fields on the left side of the pane, and the list 
boxes with the Select and Close buttons will disappear.

Using the 
BindView RMS 
Web Console

Once the BindView RMS Web Console has been installed and 
properly configured, you are ready to build a query, launch a query 
binder, launch a task list, view dataset reports, view alerts 
generated, view alert details, baseline datasets, browse the 
enterprise, manage scripts, create, modify and delete named 
scopes, as well as define default scopes.

Navigation Bar The navigation bar is the pane on the left side of the Web Console. 
It contains icons grouped into categories to allow you to navigate 
easily through the Web Console. Anything selected on the 
navigation bar will display its contents in the details pane on the 
right.
1: Overview 19
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Navigation Bar
RMS Web Console The RMS Web Console button on the navigation bar, when clicked, 
will display icons to access the Home page and Settings window, 
and to log off from the Web Console.

Query Links The Query Links button on the navigation bar, when clicked, will 
display icons to create a query, access the Enterprise Browser, 
access the Query Item Browser, and access the Task Status window.

 

Home – Displays the Query Tasks window. 
However, if you have the Enable Real-Time 
Monitor Tasks option selected, the Home page 
appears instead, displaying the Query Tasks and 
Real-Time Monitoring Tasks icons.
Settings – Allows you to access the RMS WEb 
Console Settings window to change the default 
settings, the current EDBS and Information Server, 
and to enable the Real-Time Monitoring tasks.
Log off – Logs you off the BindView RMS Web 
Console. You will be able to log back on by clicking 
the Logon button.

Query Item Browser – Allows you to browse 
currently saved query binders and task lists, launch 
queries contained in binders, launch task lists, 
modify queries, or view the contents of historical 
datasets.

Enterprise Browser – Displays a browser tree. 
From this tree you will be able to browse through a 
list of bv-Control products that publish information 
in the Enterprise browser.

Create a Query – Allows you to access the Query 
Builder dialog. From here you will be able to create 
a query by selecting a data source, adding fields, 
adding a scope, adding a filter, adding a sort, and 
finally, saving and launching the new query.

Task Status Window – Displays the status of 
running queries, baselines, and task lists. From here 
you will be able to view any unsaved dataset and 
save it to a query binder.

Exported File Browser – Allows you to view 
dataset reports exported from the Console.
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Navigation Bar
Scope Links The Scope Links button on the navigation bar, when clicked, will 
display icons to access the Named Scope Browser, create a named 
scope, and define a default named scope.

Real-Time Links The Real-Time Links button on the navigation bar when clicked 
will display icons to access the Alerts Generated and the Managed 
Scripts.

Named Scope Browser – Allows you to browse 
named scopes and manage scopes across 
datasources and bv-Control products.

Create a Named Scope – Opens the New Named 
Scope dialog in order to create a new named scope.

Assign Default Named Scope – Allows you to 
access the Default Named Scope dialog to define 
a default scope for the user.

Managed Scripts – Displays the scripts in the 
selected EDBS. You will be able to view the scripts 
assigned to different managed resources, as well as 
starting or stopping scripts if you have administrator 
privileges. By default, the Managed Scripts icon 
does not appear on the navigation bar. In order to 
display the icon, you need to select the Enable Real-
Time Monitor Tasks option from Settings> Real-
Time Monitor.

Alerts Generated – Displays all alerts in the 
selected EDBS based on the criteria contained in a 
filter. You will be able to view alert details, 
acknowledge and unacknowledge any or all alerts if 
you have admin privileges. By default, the Alerts 
Generated icon does not appear on the navigation 
bar. In order to display the icon, you need to select 
the Enable Real-Time Monitor Tasks option from 
Settings> Real-Time Monitor.
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Query Tasks
Query Tasks Query Tasks is the first window you access when you start the 
Web Console, select an Information Server, and have the Real-
Time Monitor Tasks option disabled. From this window, you can 
access your personal items, shared items, pre-defined items, your 
task status, configure your grid settings, create a new query, create 
a new named scope, assign a default named scope, browse named 
scopes, browse your enterprise, and change the Information 
Server.

Fig. 3 Query Tasks 
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Query Tasks
 

View My Personal Items – Displays the contents 
that are saved to the personal folder and linked to 
the logged-on user.

View Pre-Defined Items – Displays the folder that 
contains pre-configured query binders.

View Shared Items – Allows you to view all shared 
queries and task lists by users of the same 
Information Server.

View My Task Status – Allows you to monitor and 
manage your tasks while they are processing.

Create a New Named Scope – Allows you to 
access the New Named Scope dialog in order to 
create a named scope.

Create a New Query – Allows you to access the 
Query Builder dialog to create a new query.

Assign Default Named Scope – Allows you to 
access the Default Named Scope dialog to define a 
default scope for the user.

Browse the Enterprise – Allows you to access the 
browser tree. From this tree you will be able to 
browse through a list of bv-Control products that 
publish information in the Enterprise Browser.

View Exported Files – Allows you to view all 
exported dataset reports. 

Configure My Grid Settings – Allows you to view 
and edit the settings for both the Dataset and Task 
Status windows, view the components of the Web 
Console and their version numbers, change the 
connection to a different Information Server and/or 
EDBS, and enable the Real-Time Monitoring 
tasks.

Change BindView Information Server – Allows 
you to change the current Information Server.

Named Scope Browser – Opens the Named 
Scope Browser in order to copy, modify, or delete a 
named scope.
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Home
Home You can access the Home window once you have enabled the Real-
Time Monitor Tasks option from the Settings window and then 
clicked Home on the navigation bar. 

Fig. 4 Getting Started

Click the question mark (?) to view the help on this window.

The Details Pane displays the contents of what was selected on the 
navigation bar

The Navigation Bar allows you to manage your view of the BindView RMS 
Web Console. 

Query Tasks – Allows you to open the Query 
Tasks window.

Real-Time Monitoring Tasks – Allows you to open 
the Real-Time Monitoring Tasks window.
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Real-Time Monitoring Tasks
Real-Time Monitoring 
Tasks

The Real-Time Monitoring Tasks window allows you to access a 
set of icons in order to view a summary of alerts, the alerts 
generated, the managed scripts and also to change the EDBS.

Fig. 5 Real-Time Monitoring Tasks

View Alerts Summary – Enables you to see a 
summary of alerts generated based on the criteria 
contained in a filter.

View Managed Scripts – Allows you to access the 
scripts in the selected EDBS. You will be able to view 
the scripts assigned to different managed resources, 
as well as to start or stop scripts if you have admin 
privileges.

View Alerts Generated – Allows you to select and 
filter events by date, severity, acknowledgment 
status, machine name and script.
Change EDBS – Allows you to connect to a different 
EDBS.
1: Overview 25

© 2004 BindView Corporation. All Rights Reserved



Selecting an Event Database Server
Selecting an Event 
Database Server

The Select an Event Database Server (EDBS) window allows you 
to connect to an EDBS. You can be connected to only one EDBS at a 
time, so if you connect to a different EDBS, this will automatically 
terminate your connection with the current EDBS.

You invoke this window by clicking the Settings icon on the 
navigation bar once you are in a session, or by clicking the Alerts 
Generated or the Managed Scripts icon if you are connecting to 
the EDBS for the first time after you log on.

Enter the credentials and click Connect to establish a connection 
with the EDBS selected.

Fig. 6 Select an Event Server Database Window
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Selecting an Event Database Server
The fields and buttons available on the window are:

• Machine Name – Displays the Event Database Server computer 
that you previously selected from the Machines list box.

• Browse – Displays the Domains and the Machines list boxes to 
allow you to make a selection. Once you make your selection and 
click Select, both list boxes and the Select and Close buttons 
will disappear.

• User Name – Requires you to enter a valid User Name with 
administrative rights to connect to an EDBS. The user name 
should be in the form of domain\user name or machine\user 
name if the machine selected is a workgroup.

• Password – Requires you to enter the assigned password.
• Connect – Allows you to connect to the selected EDBS.
• Use as default – Allows you to save the Domain, the Machine, 

and the User Name entered when you select the check box.
• Domains – Allows you to select the domain the selected EDBS 

belongs to.
• Machines – Allows you to select a specific EDBS computer from 

the list box.
• Select – Acknowledges your selection from the list boxes. When 

you click this button, the information selected will be placed into 
the appropriate fields on the left side of the pane, and the list 
boxes with the Select and Close buttons will disappear.

• Close – Closes the Domains and the Machines selection boxes.
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Selecting an Event Database Server
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System Requirements
System 
Requirements

The following requirements must be met for successful installation 
and implementation of the Web Console:

Client • Microsoft® Internet Explorer v5.0 or later with Java™ Virtual 
Machine, or Netscape® Navigator v4.72 or later (except for 
version 6 and later) with Java Virtual Machine

• Microsoft® Windows® 2000 SP2, Microsoft Windows XP® or 
Microsoft Windows Server™ 2003. 
You must install the Java Virtual Machine in order to view the pie 
chart in the Alerts window and be able to create a query. The 
Java Virtual Machine is automatically installed when you choose 
custom installation of Microsoft Internet Explorer. However, 
upgrading from Microsoft Internet Explorer v4 to Microsoft 
Internet Explorer v5 does not always upgrade the Java Virtual 
Machine. If it does not, you must upgrade the Java Virtual 
Machine manually. 

IIS Server • Microsoft Windows 2000 SP2, Microsoft Windows XP, or Microsoft 
Windows Server 2003

• Microsoft Internet Information Server (IIS) v5.0 or v6.0
• Microsoft Internet Explorer v5.5 or later

BindView Information 
Server

• Microsoft Windows 2000 SP2, Microsoft Windows XP, or Microsoft 
Windows Server 2003

• BindView RMS Console and Information Server v8.00. For 
installation information, see the BindView RMS Console and 
Information Server User Guide
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Installing the Product
Installing the 
Product

BindView RMS Web Console is installed from a CD-ROM. The CD-
ROM must be available from either a local or a remotely mounted 
CD-ROM drive. If you do not have access to a CD-ROM drive, 
contact BindView Technical Support for assistance (page 14).

Before installing the Web Console on your Microsoft Internet 
Information Server machine, you must have IIS5.0 or IIS6.0 
installed.

To install the BindView RMS Web Console

1 Insert the BindView RMS infrastructure CD-ROM into your CD-
ROM drive.

2 Click Install, and then click BindView RMS Web Console.

Fig. 7 Install Panel
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Installing the Product
The Welcome panel for BindView RMS Web Console Setup 
appears (Fig. 8).  

Fig. 8 Welcome Panel

3 Click Next.

The Software License Agreement panel appears.

Fig. 9 Software License Agreement Panel

4 Read the license agreement and click Yes to accept the terms of 
the agreement. 
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Enabling IIS 6 Web Server
The Choose Destination Location panel appears.

Fig. 10 Choose Destination Location Panel

5 Enter the path to the directory where you would like the Web 
Console to be installed, or select it using the Browse button.

The default directory is Inetpub\wwwroot\RMS.

6 Click Next to continue.

The Setup Complete panel appears (Fig. 11). 

Fig. 11 Setup Complete Panel

7 Click Finish to complete the installation.

Enabling IIS 6 
Web Server

By default, Internet Information Server 6 is not installed on 
Windows Server 2003 systems. In order to use the BindView RMS 
Web Console on Windows Server 2003 systems, you must first 
install IIS6, and then enable the BindView RMS Web Console to use 
it. 
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Enabling IIS 6 Web Server
To make these changes, you must be a member of the 
Administrators group on the local machine or be delegated the 
appropriate authority. 

To configure Windows Server 2003 and IIS6

1 Select Start>Administrative Tools>Internet Information 
Services (IIS) Manager.

The Internet Information Services window opens.

2 Click the plus (+) sign next to the name of the local machine 
container to expand it, then click the Web Service Extensions 
container. 

Fig. 12 Web Service Extensions Container

3 In the details pane, note the Active Server Pages item. If it is 
not allowed, select it and click Allow. 

4 Click the plus (+) sign next to the Web Sites container to 
expand it, then expand the Default Web Site container. 
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Enabling IIS 6 Web Server
5 Right-click the RMS container and choose Properties from the 
menu. The RMS Properties dialog appears. 

Fig. 13 RMS Properties Dialog 

6 If it is not selected already, select the Virtual Directory tab, 
then click Configuration. The Application Configuration 
dialog appears. 

Fig. 14 Application Configuration Dialog 
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Enabling IIS 6 Web Server
7 Select the Options tab. 

Fig. 15 Application Configuration Dialog - Options Tab

8 If it is not selected, select Enable parent paths. 

9 Click OK to close the Application Configuration dialog.

10 Click OK to close the RMS Properties dialog. 

11 Exit the Internet Information Services (IIS) Manager.

This configuration allows the BindView RMS Web Console to run on 
the Windows Server 2003 machine and serve BindView RMS Web 
Console pages to other machines. If you wish to view BindView RMS 
Web Console pages on the Windows Server 2003 machine, you 
must also install the Microsoft Windows Virtual Machine (VM) 
software. 
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Configuring the Secure Sockets Layer
Configuring the 
Secure Sockets 
Layer

In order to make your Web Console Web site secured so no one will 
be able to intercept communication between your Web server and 
the client, you must configure the Secure Sockets Layer (SSL) 
protocol. This requires that you obtain a Digital Certificate from a 
Certifying Authority and install it on your IIS server. For additional 
information on installing a digital certificate, see your IIS 
documentation.

After installing the digital certificate, use the following sections to 
configure the SSL for Microsoft Windows Server 2003 or Microsoft 
Windows 2000.

To configure the SSL for Windows Server 2003 and IIS 6 
or Windows 2000 and IIS5

1 On Windows Server 2003 machines, select 
Start>Administrative Tools>Internet Information 
Services (IIS) Manager. On Windows 2000 machines, select 
Start>Programs>Administrative Tools>Internet 
Services Manager.

The Internet Information Services window appears.

Fig. 16 Internet Information Services Window

2 Expand the Default Web Site.

3 Right-click on RMS and select Properties from the popup 
menu.
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Configuring the Secure Sockets Layer
The RMS Properties dialog appears.

Fig. 17 RMS Properties Dialog

4 Click on the Directory Security tab.

Fig. 18 RMS Properties Dialog - Directory Security Tab

5 Click Edit in the Secure communications section.
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Configuring the Secure Sockets Layer
The Secure Communications dialog appears.

Fig. 19 Secure Communications Dialog

6 Select the Require secure channel (SSL) check box.

7 Select the Require 128-bit encryption check box if you wish 
to require 128-bit encryption to be used (optional).

8 Click OK in the Secure Communications dialog.

9 Click OK on the RMS Properties dialog.

10 Close the Internet Information Services Manager. 
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Configuring the Secure Sockets Layer
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Configuring the Web Console
Configuring the 
Web Console

The Settings window allows you to view and modify the settings for 
both the Dataset and Task Status windows, view the components 
of the Web Console and their version numbers, enable the Real-
Time Monitoring tasks, and change the connection to a different 
Information Server and/or EDBS.

To connect to the BindView RMS Web Console, use the address 
http://<machine name>/RMS in Internet Explorer or Netscape 
Navigator, where <machine name> is the name or IP address of the 
BindView RMS Web Console machine. 

You open the Settings window by clicking the RMS Web Console 
button on the navigation bar and then clicking the Settings icon.

Fig. 20 Settings Window - Queries Tab
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Queries
Queries The Queries tab displays the current Information Server, the 
number of rows to be displayed in the Dataset window, the number 
of seconds used to refresh the Task Status window, and the 
number of characters to display per field in the grid.

To change the number of rows

The default number of rows is 10 and can be changed to any 
number from 1 to 32767.

A large number of rows slows display of the page. You should 
generally display 1000 or fewer rows if possible. If you choose to 
display more than 5000 rows, display of the resulting page can take 
several minutes or more. 

1 Click the Queries tab (Fig. 20).

2 Enter the desired number of rows in the corresponding field.

3 Click Save.

A message appears, confirming that the Settings are 
successfully saved.

4 Click OK.

For information on the Dataset window, see “Displaying Saved 
Datasets” on page 77 or “Viewing Unsaved Datasets” on page 85.

To change the number of seconds

The default number of seconds to refresh the Task Status window 
is 15 and can be changed to any number from 1 to 3600.

1 Click the Queries tab (Fig. 20).

2 Enter the desired number of seconds to use in the 
corresponding field.

3 Click Save.

A message appears, confirming that the Settings are 
successfully saved.

4 Click OK.

For information on the Task Status window, see “Monitoring the 
Status of Processed Tasks” on page 82.
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Queries
To change the number of characters to display per field

The default number of characters to display per field in the Dataset 
window is 260 and can be changed to any number from 10 to 1024.

1 Click the Queries tab (Fig. 20).

2 Enter the desired number of characters to display per field in 
the corresponding field.

3 Click Save.

A message appears, confirming that the Settings are 
successfully saved.

4 Click OK.

For information on the Dataset window, see “Viewing Unsaved 
Datasets” on page 85.

To change the current Information Server

1 Click the Queries tab (Fig. 20).

2 Click Change.

A message appears, warning you that you will be disconnected 
from the current Information Server.

3 Click OK to continue.

The logon window appears.

The Located on web server machine check box only appears if 
you are running Windows 2000 or Windows Server 2003 and you 
have both the IIS and the Web Gateway Service installed on the 
same machine. When you clear this check box, the Browse button 
is enabled, and you can select a domain and a machine from the 
corresponding pick lists.
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Queries
Fig. 21 Selecting a BindView Information Server Window

4 Click the browse (...) button.

The Domains and Machines list boxes appear in the window.

5 Select a domain and a machine name and click Select to 
acknowledge your selection from the list boxes.

6 Enter a valid User Name with administrative rights to connect 
to the selected Information Server. The user name should be in 
the form of domain\user name or machine\user name if 
the machine selected is a workgroup.

7 Enter the assigned Password.

8 Check the Remember the machine and user names option 
if you want to save the Machine, and the User Name you 
entered for the next time you log in using the current machine.

9 Click Connect.

For additional information on selecting an Information Server, see 
“Selecting a BindView Information Server” on page 18.
3: Settings 45

© 2004 BindView Corporation. All Rights Reserved



Real-Time Monitor
Real-Time Monitor The Real-Time Monitor tab (Fig. 22) allows you to enable the 
Real-Time Monitor Tasks option and view or change the EDBS to 
which you are currently connected.

Fig. 22 Settings Window - Real-Time Monitor Tab

To enable the Real-Time Monitor Tasks

1 Click the Real-Time Monitor tab.

2 Select the Enable Real-Time Monitor Tasks check box.

The current EDBS information appears in the details pane and 
both the Alerts Generated and the Managed Scripts icons 
appear on the navigation bar. For information on the 
functionality of these icons, see Chapter 9, “Real-Time 
Monitoring Services,” on page 111.

To change the current EDBS

1 Click the Real-Time Monitor tab (Fig. 22).

2 Select the Enable Real-Time Monitor Tasks check box.

The current EDBS information appears in the details pane.

3 Click Change.
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Real-Time Monitor
The Select an Event Database Server window appears.

Fig. 23 Selecting an EDBS Window

4 Click Browse.

The Domains and Machines list boxes appear on the window.

5 Select a domain and a machine name, and click Select to 
acknowledge your selection from the list boxes.

6 Enter a valid User Name with administrative rights to connect 
to the selected EDBS. The user name should be in the form of 
domain\user name or machine\user name, if the machine 
selected is a workgroup.

7 Enter the assigned Password.

8 Check the Use as default option if you want to save the 
Domain, the Machine, and the User Name you entered for the 
next time you log in using the current machine.

9 Click Connect.

For additional information on selecting an Event Database Server, 
see “Selecting an Event Database Server” on page 26.
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Version Information
Version 
Information

The Version Information tab (Fig. 24) is for information purposes 
only. It displays a list of the different components of the Web 
Console and their version numbers.

Fig. 24 Settings Window - Version Information Tab
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Understanding Queries
Understanding 
Queries

A query is a question you define and submit to the Information 
Server to receive specific information about resource objects. When 
you run a query, information about resource objects is returned as 
records in a dataset.

You can access the query icons by clicking the Query Links button 
on the navigation bar. The Create a Query icon will not appear on 
the navigation bar if you do not have the right to create queries.

Creating a New 
Query

The Query Builder dialog is used to create a new query or modify 
an existing one. The selections you make in this dialog are 
collectively known as the query definition.

The Java™ Virtual Machine must be installed in order to create 
queries.

When you create a new query, you must do the following:

• Select a data source
• Add at least one field
• Add a scope (only required by some query-based products)

You may also choose to do the following:

• Add a filter
• Add a sort criteria

Selecting a Data 
Source

You must select a data source for the query definition. A data 
source represents a resource object or a collection of resource 
objects.

To connect to the BindView RMS Web Console, use the address 
http://<machine name>/RMS in Internet Explorer or Netscape 
Navigator, where <machine name> is the name or IP address of the 
BindView RMS Web Console machine. 

To select a data source

1 Click the Query Links button on the navigation bar.

2 Click the Create a Query  icon.

The Query Builder dialog appears, defaulting to the Data 
Sources tab.
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Selecting a Data Source
 

Fig. 25 Query Builder Dialog - Data Sources Tab

3 Select the desired data source in the Available Data Sources 
list.

4 If the data source you select has default fields associated with 
it, you can click OK now to process the query with the default 
fields. Otherwise, you have to add at least one field to the 
selected data source before you can proceed.
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Adding Fields
Adding Fields Fields represent the attributes, or properties, of the resource 
objects represented by the data source.

The Field tab of the Query Builder dialog allows you to add fields 
to the query definition. A query definition must contain at least one 
field.

The fields you add define the types of information you want to 
receive about the selected resource objects.

To add a field

1 Select the desired field in the available fields list, or enter a 
field name into the Filter Field Names box to quickly search 
for a specific field.

Fig. 26 Query Builder Dialog - Field Tab

2 Click Add.

The field appears in the Selected Fields list.

You can also add fields by double-clicking the desired field or by 
dragging-and-dropping the desired field into the Selected 
Fields box.

Fields appear in the dataset in the order they appear in the 
Selected Fields list. You can change the field order by 
dragging-and-dropping fields into your preferred order.

For more information on managing fields in the Selected Fields 
list, see “Managing Fields Added to a Query Definition” on page 57.
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Adding Descriptor Fields
Adding Descriptor 
Fields

A descriptor field requires a user-supplied descriptor value that 
further defines the specific attributes the field represents.

You must supply descriptor values before the Information Server 
can process a query that contains descriptor fields. You supply 
descriptor values either immediately after adding a descriptor field 
to a query definition, or each time the query is run.

Each descriptor field has a corresponding Descriptor dialog.

To add a descriptor field

1 Select the desired descriptor field in the Available Fields list 
and click Add.

A Descriptor dialog for the descriptor field appears. 

Fig. 27 Adding a Descriptor Field

2 Select Descriptor Value and define a value immediately, or 
select Prompt Value to delay the definition of the descriptor 
value. For information on defining a descriptor value, see “To 
define a Descriptor Value for a descriptor field”.

3 Click OK.

The descriptor field appears in the Selected Fields list.
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Adding Descriptor Fields
To define a Descriptor Value for a descriptor field

1 Select Descriptor Value on the Descriptor dialog.

2 Define the Date/Time. 

Fig. 28 Defining a Specific Value

3 Click OK.

To define a Prompt Value for a descriptor field

1 Select Prompt Value on the Descriptor dialog (Fig. 29).

2 Enter the desired message in the Enter Prompt Text box. 

Fig. 29 Defining a Prompt Value

The prompt text appears on the Query Completion Wizard 
when you run the query.

3 Click OK to go back to the Field tab.
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Adding Descriptor Fields
Adding Custom Fields You add custom fields to a query definition when you want to 
annotate the query with specific information.

All custom fields are descriptor fields. 

Fig. 30 Custom Field Types and Location
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Adding Descriptor Fields
Filtering the Available 
Fields List

The Filter Field Names box with the Apply button allows you to 
quickly search for a specific field.

Fig. 31 Field Features

Reviewing Field 
Descriptions

The Field Info button opens a dialog that contains a description of 
the field selected in the available fields list.
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Managing Fields Added to a Query Definition
Managing Fields 
Added to a Query 
Definition

The field management buttons on the Field tab allow you to 
manage fields from the query definition.

Fig. 32 Field Management Buttons

Removing Fields From 
the Query Definition

You can use the Remove or Remove All buttons to remove fields 
from the Selected Fields list. These buttons remove fields from the 
query definition.

Modifying Descriptor 
Selections

You can use the Descriptor button to modify the selections you 
have chosen for the descriptor field when you added it to the query 
definition.

The Descriptor button is only enabled when you select a field in 
the Selected Fields list.
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Adding Filters
Adding Filters Adding a filter allows you to reduce the number of records returned 
in the dataset for the selected resource objects. Filters consist of 
one or multiple filter terms that you define. Filter term definitions 
include a value, or a group of values, that you selected for the filter 
term. A filter term value defines the record types to be returned in 
the dataset.

You must supply all filter term values before the Information Server 
can process a query that contains a filter. You supply filter term 
values immediately after adding a filter field to a query definition.

When the Information Server processes a query, it applies the filter 
to each record it gathers for the selected resource objects. Only the 
records that match the filter are included in the dataset.

Filters are not required in query definitions. If no filter is included, 
every record in the selected resource object will be included in the 
dataset. 

To add a filter term

1 Click the Filter tab on the Query Builder dialog. 

Fig. 33 Query Builder - Filter Tab

2 Select a field for which you want to define a filter term and click 
Add, or enter a filter field name into the Filter Field Names 
box to quickly search for a specific field.
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Adding Filters
The Filter Term Definition dialog appears (Fig. 34). 

Fig. 34 Filter Term Definition Dialog

The configuration of the Filter Term Definition dialog 
depends on the query-based product you are using and the 
resource objects you selected.

3 Select Specific Value, Another Field, or Prompt User to 
define a filter term for the field.

For detailed information on defining a filter term or delaying the 
definition of a filter term, proceed to one of the following:

“To define a specific value” on page 59

“To define another field value” on page 60

“To define a Prompt Value for a descriptor field” on page 54

4 Click OK.

The filter term appears in the Operator/Expression box on 
the Filter tab.

For information on managing filter terms, see “Managing Filter 
Terms” on page 62.

To define a specific value

1 Select Specific Value (Fig. 35).
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Adding Filters
2 Select the desired operator from the operator list. 

Fig. 35 Defining a Specific Value

3 Enter a specific value for the operator in the Specify a Value 
box.

If the field selected is Date/Time, the Date/Time Value 
Helper dialog appears when you click the browse (...) button. 

Fig. 36 Date/Time Value Helper

4 Specify the date and time, and select the UTC check box if the 
time is Universal Time Coordinate.

5 Click OK.

To define another field value

1 Select Another Field (Fig. 37).
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Adding Filters
2 Select the desired operator from the operator list.

Fig. 37 Defining Another Field Value

3 Select the desired field from the field list.

Filter terms containing Another Field value filter records that 
match both the target field and the comparison field.

4 Click OK. 

To define a prompt user value

1 Select Prompt User (Fig. 38).

2 Select the desired operator from the operator list.

3 Enter the desired prompt user text. 

Fig. 38 Defining a Prompt User Value

The prompt text and selected operator appear on the Query 
Completion Wizard when you run the query.

4 Click OK to return to the Filter tab. 
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Managing Filter Terms
Managing Filter Terms The filter term management buttons are used on the Filter tab to 
manage filter terms. 

Fig. 39 Filter Term Management Buttons

You manage filter terms by:

• Modifying filter term definitions
• Removing filter terms
• Modifying AND/OR operators
• Grouping filter terms using parentheses

Modifying Filter Term 
Definitions

You can use the Modify button to modify the filter term you 
previously defined for the selected field (Fig. 39). The Modify 
button opens the Filter Term Definition dialog configured with the 
filter term selections.

For detailed information the using Filter Definition dialogs, see 
“Adding Filters” on page 58.

Removing Filter Terms You can use the Remove or Remove All buttons to remove filter 
terms from the Operator/Expression list (Fig. 39 on page 62).

Modifying AND/OR 
Operators

You can use the AND/OR button to change the operator of the 
selected filter term. By default, all filter terms use the AND 
operator.
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Adding Sorts
Grouping Filter Terms 
Using Parentheses

You can use the Add parentheses buttons to group two or more 
filter terms that you want to function as a single unit, or use the 
Remove parentheses buttons to ungroup these filter terms.

To group filter terms

1 Select the filter term on which you want the group to begin.

2 Click the Add open parenthesis button.

3 Select the filter term on which you want the group to end.

4 Click the Add close parenthesis button.

To ungroup filter terms

1 Select the first filter term of the group.

2 Click the Remove open parenthesis button.

3 Select the last filter term of the group.

4 Click the Remove close parenthesis button.

Adding Sorts Sorts determine the order in which sort fields and records appear in 
the selected view type. You can only apply sorts to fields that you 
added to the query definition.

Sorts consist of a group of sort fields. Individual sort field records 
are displayed in ascending or descending order in the dataset.

Sorts are optional in query definitions.
4: Query Services 63

© 2004 BindView Corporation. All Rights Reserved



Adding Sorts
To add a sort

1 Click the Sort tab on the Query Builder dialog. 

Fig. 40 Query Builder Dialog - Sort Tab

2 Select the desired field from the Available Fields list and click 
Add.

The sort field appears in the Selected Fields box.

By default, the sort field records appear in ascending order in 
the dataset. For information on managing sorts, see “Managing 
Sort Fields” on page 65.

You can change the sort order of the field records by dragging 
and dropping the desired field into the Selected Fields list.
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Managing Sort Fields
Managing Sort Fields You can use the sort field management buttons on the Sort tab to 
manage sort fields. 

Fig. 41 Managing Sort Fields

You can manage sort fields by:

• Modifying sort directions
• Removing sort fields
• Modifying duplicate key options

Modifying Sort 
Directions

Use the Toggle Sort button to change the direction of the sort 
order for the records returned for the sort field (Fig. 41).

You can also change the sort direction by double-clicking on the 
desired sort field in the Selected Fields list.

Removing Sort Fields You can use the Remove or Remove All buttons to remove sort 
fields from the Selected Fields list.
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Adding Scopes
Modifying Duplicate 
Sort Key Options

A sort key is a subset of the attribute values collected for each 
resource object.

You can use the option buttons in the Select Duplicate Key 
Options box to define how records with duplicate sort keys are 
included in the dataset (Fig. 42).

Fig. 42 Selecting Duplicate Key Options

Adding Scopes A scope narrows the range of resource objects to be queried.

Since the Information Server only queries the resource objects 
indicated by the scope, you can use scopes to reduce the time it 
takes to retrieve a dataset.
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Adding and Removing Resource Objects
Adding and Removing 
Resource Objects

The Scope tab functions in a similar manner for all bv-Control 
products.

• The Add Scope button adds the resource object selected in the 
available resource objects box to the scope (Fig. 43).
The Tracking Log and the Tracking Log Summary are two 
resource objects that cannot be added to the scope because they 
are not supported in the Web Console. You must create Named 
Scopes on the Information Server to add these resource objects.

• The Remove Scope button removes the resource object selected 
in the selected resource object box from the scope (Fig. 43). 

Fig. 43 Adding and Removing Resource Objects

Using Default Scopes All bv-Control products that require scopes provide a default scope. 
The default scope appears as the selected scope when you first 
access the Scope tab. For more information on default scopes or 
named scopes, see Chapter 8, “Scope Manager,” on page 103.

Saving Named Scopes The Save as Named Scope button opens a dialog you use to save 
the selected scope items as a named scope on the Information 
Server. For more information on saving a named scope, see 
“Duplicate a Named Scope” on page 108.
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Running Queries
Running Queries When you run a query, the resource objects you selected in the 
query definition are polled for the information you requested. This 
information is returned in a dataset.

You run a query from two places:

• Query Options dialog
• Query Item Browser

Running Queries from 
the Query Options 
Dialog

You use the Query Options dialog to save and launch queries.

To run a query

1 Click the Query Links button on the navigation bar.

2 Click the Create a Query  icon.

The Query Builder dialog appears, defaulting to the Data 
Sources tab.

3 Create and define a query and click OK.

For information on creating and defining queries, see “Creating 
a New Query” on page 50.

The Query Options dialog appears. 

Fig. 44 Query Options Dialog

4 Select Launch Query and click OK.
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Using the Query Completion Wizard
The Save Query dialog appears if you have selected to save 
the query. 

Fig. 45 Save Query Dialog

5 Enter a name for the binder where you want to save the query 
and click Save.

Using the Query 
Completion Wizard

The Query Completion Wizard appears each time when you run a 
query that is missing specific information, such as descriptor field, 
filter, or scope. You must use the Query Completion Wizard to 
enter the required information before the Information Server can 
process the query.

To use the Query Completion Wizard

1 Click Next on the Welcome panel of the Query Completion 
Wizard (Fig. 46). 

Fig. 46 Welcome Panel
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Using the Query Completion Wizard
The Descriptor panel appears. 

Fig. 47 Directory Descriptor Panel

2 Click Change Descriptor to specify a descriptor if any are 
missing, or click Next to continue.

The Filter panel for defining the descriptor filter appears. 

Fig. 48 Filter Descriptor Panel

3 Use the options on the panel to complete the information 
required in the query definition.

4 Click Next.
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Using the Query Completion Wizard
The Scope panel appears listing all default scopes (Fig. 49). 

Fig. 49 Scope Panel

5 Choose a default scope or click the Change Scope button to 
select a scope from a dialog. Click Next.

After you complete all required information for the query 
definition, the Completing the Query Completion Wizard 
panel appears (Fig. 50). 

Fig. 50 Completing the Query Completion Wizard Panel

6 Click Finish to launch the query.

The Information Server gathers the requested information from 
the selected resource objects and returns a dataset.
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Query Binders
Query Binders The Web Console allows you to perform the following query-related 
tasks to view information about your network:

• Launching a Query
• Launching a Task List
• Modifying a Query
• Accessing a Query Binder
• Displaying Saved Datasets
• Viewing Information About a Query
• Viewing Exported Files
• Saving Datasets (See “Saving Datasets to Query Binders” on 

page 83). 

Fig. 51 Contents of My Items

At the top of the Query Item Browser window, a folder appears 
containing the Shared folder, the My Items folder, and the 
Pre-Defined folder. The Pre-Defined and Shared folders are 
public folders. Anyone connected to the Information Server can 
access the files stored in these folders. The Personal folder is a 
private folder.

Shared folder – allows users of the same Information Server to 
share queries and task lists. The queries and task lists appearing in 
the Shared folder can be accessed by all users who connect to the 
Information Server.
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Launching a Query
My Items folder – the default folder for all saved queries and task 
lists. Contents saved to this folder are linked to the logged-on user, 
and by default, cannot be viewed by other users even though 
connected to the same Information Server.

Pre-Defined folder – contains pre-configured query binder files 
and task lists for all query-based BindView products added to the 
BindView RMS Console and Information Server. Each bv-Control 
product will have its own subfolder under the Pre-Defined folder.

Launching a Query The following is an example of a query being launched from the 
Query Item Browser. For information on how to run a query from a 
Query Options dialog, see “Running Queries from the Query 
Options Dialog” on page 68.

To launch a query

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your 
\My Items folder.

All incomplete queries display an asterisk next to the Launch 
icon.

3 Click the Launch  icon to launch the query contained in the 

query binder.

If the query you want to launch is incomplete, an asterisk (*) 
will be displayed next to the query in the Query Item 
Browser. When you click this query, the Query Completion 
Wizard appears so that you can complete it before launching 
it. However, if the query is complete, a message appears, 
confirming that the query was successfully launched. 

4 Click OK.
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Launching a Task List
Launching a Task List When you add a query or a baseline to the task list and save it in 
the BindView RMS Console, this task list will immediately appear in 
the Query Item Browser in the Web Console. For information on 
how to add a query or a baseline to a task list in the Console, see 
the BindView RMS Console and Information Server User Guide.

To launch a task list

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your \My 
Items folder.

3 Click the Launch  icon to launch the task list saved from 

the BindView RMS Console.

The following message appears, confirming that the job was 
successfully launched. 

4 Click OK to dismiss the message.

Modifying a Query The Modify icon opens the Query Builder dialog so that the query 
can be modified.

To modify a query

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your 
\My Items folder.

3 Click the Modify  icon for the query you want to modify.

The Query Builder dialog appears, defaulting to the Data 
Sources tab.

4 Edit the query and click OK.
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Accessing a Query Binder
The Query Options dialog appears.

Fig. 52 Query Options Dialog

5 Select the option you need to perform, or leave the default 
selections and click OK.

For additional information on modifying a query, see “Creating a 
New Query” on page 50.

Accessing a Query 
Binder

A query binder is a discrete object for storing and managing queries 
and query-related information. Each saved query binder is stored in 
the BindView Information Server’s database. 

To view a query binder

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your 
\My Items folder.

3 Click the binder  icon for the datasets you wish to view.
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Accessing a Query Binder
The Dataset Browser appears in the details pane, listing all 
datasets in the query binder and stating the time the query was 
started and the time it was completed (Fig. 53).

Fig. 53 Datasets Window
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Displaying Saved Datasets
Displaying Saved 
Datasets

The information obtained from a dataset is displayed in a grid 
format. A grid organizes the data returned by the query in a 
spreadsheet. This spreadsheet contains a column for each field in 
the query. The columns contain all the data returned by a field. 
Each row on the grid is a record. The Settings window configures 
the number of rows displayed in the grid. 

Fig. 54 Historical Dataset Window

To view a historical dataset

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your 
\My Items folder.

3 Click the binder  icon for the dataset you wish to view.

The Dataset Browser appears in the details pane listing all 
datasets in the selected query binder.

4 Click the View Dataset  icon for the dataset you want to 
view.

The dataset is retrieved and displayed in a grid format (Fig. 
54).
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Viewing Information About a Query
The grid displays a default of 10 rows. This default setting is 
configurable and can be changed through the Settings window. For 
information on how to change this default, see “To change the 
number of rows” on page 43.

Viewing Information 
About a Query

The Query Information icon opens an information page about the 
query. Information displayed includes the item’s name and location, 
a short description, and information about the product, fields, 
filters, and scopes used in the query. 

To view information about a query

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your \My Items 
folder.

3 Click the Information  icon for the query you want to 
modify.

The Query Information page appears. 

Fig. 55 Query Information Page
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Viewing Exported Files
Viewing Exported 
Files 

You can export a dataset report as an Adobe Acrobat (.pdf) 
document (Fig. 56), an HTML file, a Microsoft Word (.doc) 
document, a text (.txt) document, a Microsoft Excel (.xls) 
spreadsheet (Fig. 57), or a Microsoft Access database (.mdb) from 
the Console to the BindView RMS Web Console using the export 
feature in order to view those reports.

To view an exported dataset report

1 Click the Query Links button on the navigation bar.

2 Click the Exported File Browser  icon.

The Exported File Browser appears in the details pane, listing 
any dataset reports exported from the Console.

3 Click the icon for the dataset report to view.

The dataset report window appears. 

Fig. 56 Dataset Report in PDF Format 
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Viewing Exported Files
Fig. 57 Dataset Report in XLS Format
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5 Task Status Monitoring
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Monitoring the Status of Processed Tasks
Monitoring the 
Status of 
Processed Tasks

The Task Status window offers you a quick and easy way to 
monitor and manage queries, baselines, and task lists while they 
are running. The Task Status window will indicate if the task is still 
processing, or if it did not process due to an error (Fig. 58).

The Task Status window displays the status of running, completed, 
and attempted tasks. You open the Task Status window by clicking 
the Query Links button on the navigation bar and then clicking the 
Task Status Window icon. 

Fig. 58 Task Status Window

The Task Status window refreshes every 15 seconds by default. 
This default setting is configurable and can be changed through the 
Settings window. For information on how to change this default, 
see “To change the number of seconds” on page 43.
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Saving Datasets to Query Binders
Saving Datasets to 
Query Binders

The Save Dataset window allows you to save datasets in query 
binders. Query binders are convenient items for storing and 
managing query-related information. A query binder must contain, 
at a minimum, one dataset.

To save a dataset

1 Click the Query Links button on the navigation bar.

2 Click the Task Status Window  icon.

The Task Status window appears in the details pane, listing all 
queries whose results have not been saved back to their query 
binder, as well as any baselines and task lists available (Fig. 
58).

3 Click the Save  icon for the dataset you want to save. 
Although you can save a query from the Task Status window, 
you will not be able to save a baseline or a task list.

The Save Dataset window appears (Fig. 59), listing a default 
binder name for where to save the dataset. The default binder 
name is the same binder from where the query was executed. 

Fig. 59 Save Dataset Window

4 To save the dataset into a different existing binder, enter the 
binder name and select the check box. This will overwrite the 
existing dataset and query in the binder selected.
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Deleting Jobs
When saving a dataset into the query binder from where it was 
executed, only the query will be overwritten and not the 
dataset.

5 Accept the default or change the binder name and click Save.

The Launch Query message appears, confirming that the 
dataset was successfully saved. 

6 Click OK.

Deleting Jobs The Delete feature allows you to delete any running or completed 
job.

To delete a job

1 Click the Query Links button on the navigation bar.

2 Click the Task Status Window  icon.

The Task Status window appears in the details pane, listing all 
queries whose results have not been saved back to their query 
binder, as well as any baselines and task lists available (Fig. 
58).

3 Click the Delete  icon for the job you want to delete. This 

will delete any data collected.

The Delete Job message appears, confirming that the job was 
successfully deleted. 

4 Click OK.
84 BindView RMS Web Console User Guide

© 2004 BindView Corporation. All Rights Reserved



Halting Jobs
Halting Jobs The Halt feature allows you to halt any running job that is currently 
being processed.

To halt a job

1 Click the Query Links button on the navigation bar.

2 Click the Task Status Window  icon.

The Task Status window appears in the details pane, listing all 
queries whose results have not been saved back to their query 
binder, as well as any baselines and task lists available (Fig. 
58).

3 Click the Halt  icon for the job you want to stop. Any data 
that was collected so far will be retained.

The Halt Job message appears, confirming that the job was 
successfully halted. 

4 Click OK.

Viewing Unsaved 
Datasets

This feature allows you to view completed task lists and baselines, 
as well as any queries whose results have not been saved back to 
their query binder.

To view an unsaved dataset

1 Click the Query Links button on the navigation bar.

2 Click the Task Status Window  icon.

The Task Status window appears in the details pane, listing all 
queries whose results have not been saved back to their query 
binder, as well as any baselines and task lists available (Fig. 
58).

3 Click on the dataset you want to view.
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Viewing Unsaved Datasets
The dataset will be retrieved and displayed in a grid format 
(Fig. 60). 

Fig. 60 Unsaved Datasets Window

The grid displays a default of 10 rows. This default setting is 
configurable and can be changed through the Settings window. For 
information on how to change this default, see “To change the 
number of rows” on page 43.

The lower left of the grid displays the number of records in the 
dataset as well as the total number of any messages pertaining to 
this dataset. If there is at least one message for this dataset, a 
Messages button will appear at the lower right of the grid. By 
clicking the Messages button, a window appears displaying the 
messages.

Certain columns display a Details link. This shows that the 
BindView RMS Web Console is configured to display only a certain 
number of characters in a field inside a column. When this number 
surpasses the Web Console settings, the word Details appears, so 
that you can click it and view the entire characters available per 
field.
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Viewing Task List Summary
Viewing Task List 
Summary

You can view a summary for the task lists that you created in the 
Console and launched either from the BindView RMS Console or the 
Query Item Browser in the BindView RMS Web Console.

To view a task list summary

1 Click the Query Links button on the navigation bar.

2 Click the Task Status Window  icon.

The Task Status window appears in the details pane, listing all 
queries whose results have not been saved back to their query 
binder, as well as any baselines and task lists available (Fig. 
58).

3 Click on the task list for which you want to view a summary.

The Task List Summary window appears (Fig. 61).

Fig. 61 Task List Summary Window

4 View the Task List Summary. When you have finished, close 
the window. 
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Viewing Task List Summary
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6 Baselining
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Undestanding a Baseline
Undestanding a 
Baseline

A baseline is a comparison of two historical datasets linked to a 
query binder. You must have at least two datasets in a binder in 
order to use the baseline feature.

To baseline two historical datasets

1 Click the Query Links button on the navigation bar.

2 Click the Query Item Browser  icon.

The Query Item Browser appears in the details pane, listing 
all query binders or task lists currently saved in your 
\My Items folder.

3 Click the binder  icon for the datasets you wish to baseline.

The Dataset Browser appears in the details pane, listing all 
datasets in the query binder. 

Fig. 62 Datasets in Query Binder Window

4 Select the two historical datasets that you wish to baseline by 
selecting the corresponding check box, then click Run 
Baseline.
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Undestanding a Baseline
The Run Baseline button appears disabled until you select two 
datasets to baseline. This is true for Microsoft Internet Explorer 
only. Once you select the datasets to baseline, the check boxes 
corresponding to other available datasets will be disabled and 
you will not be able to select any of them unless you clear a 
check box of a previously selected dataset.

The Baseline Options dialog appears, with the first three 
record status options selected by default. 

Fig. 63 Baseline Options Dialog

5 Select the desired record status options and click OK.

The Launch Query message appears.

6 Click OK.
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Monitoring the Status of Baselined Datasets
Monitoring the 
Status of 
Baselined 
Datasets

The Task Status window allows you to monitor baselined datasets 
by observing their associated status icons, and to delete dataset 
records by clicking the delete icon. For information on deleting a 
baselined dataset, see “Deleting Jobs” on page 84.

Open the Task Status window by clicking the Query Links button 
on the navigation bar and then clicking the Task Status Window 
icon. For additional information on the Task Status window, see 
“Task Status Monitoring” on page 81. 

Fig. 64 Baselined Dataset Task Status Window

The Type column allows you to see whether your task is a query, a 
baseline, or a task list.
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Viewing a Baseline Grid
Viewing a Baseline 
Grid

The baseline grid displays all records from the two historical 
datasets that match the selected record status options. Each record 
status has an icon associated with it (Fig. 65).

You open the View Baseline window by clicking on the desired 
baseline name from the Task Status window. 

Fig. 65 Baseline Grid

Each record status option is represented by an icon, as shown 
below: 

For additional information on the grid, see “Viewing Unsaved 
Datasets” on page 85.

Added – Displays all records that were added to the 
compared dataset.

Deleted – Displays all records that were deleted 
from the baselined dataset.

Changed – Displays all records that were changed.

Unchanged – Displays all records that were 
unchanged.
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Viewing a Baseline Grid
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7 Enterprise Browser
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Browsing the Enterprise
Browsing the 
Enterprise

The Enterprise Browser is a tree that enables you to browse 
through a list of bv-Control products that publish information in the 
Enterprise browser and filter records, as well as limit the number 
of records to display. See your specific bv-Control product user 
guide to learn more on how the product uses the Enterprise 
Browser.

You open the Enterprise Browser by clicking the Query Links 
button on the navigation bar and then clicking the Enterprise 
Browser icon.  

Fig. 66 Enterprise Browser

To filter a node

1 Click the Query Links button on the navigation bar (Fig. 66).

2 Click the Enterprise Browser  icon.

The Enterprise Browser tree appears in the details pane.

3 Double-click on the root node or single-click on the plus (+) 
sign in the left pane to expand the tree.
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Browsing the Enterprise
The tree expands and displays all the nodes available in the 
enterprise.  

Fig. 67 Enterprise Browser Tree

4 Right-click on a container node to display the popup menu.

5 Select the Filter command.
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Browsing the Enterprise
The Filter Specification dialog appears. 

Fig. 68 Filter Specification Dialog - Filter Tab

6 Specify the filter criteria. For more information on filters, see 
“Adding Filters” on page 58.

7 Click OK.

Clicking the Cancel button on the Filter Specifications tab closes 
the dialog and lists in the tree all the bv-Control products that 
publish information in the browser.

To specify a range

1 Click the Query Links button on the navigation bar (Fig. 66).

2 Click the Enterprise Browser  icon.

The Enterprise Browser tree appears in the details pane.

3 Click on the root node on the left pane to expand the tree.

The tree expands and displays all the nodes available in the 
enterprise.

4 Right-click on a container node to display the pop-up menu.

5 Select the Filter command.

The Filter Specification dialog appears.
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Browsing the Enterprise
6 Click the Display Range tab to narrow the filtering further. 

Fig. 69 Filter Specification Dialog - Display Range Tab

7 Choose to either display all the records by selecting the 
Display All Rows check box or specify the number of rows and 
the range by entering a value into the appropriate fields.

If you choose not to select the Display All Rows option, this 
will not reduce the time in retrieving all the records that match 
the filter. This is because all the records that match a filter will 
be retrieved anyway, but only the range specified will be 
displayed.

8 Click OK.

The Filter Specification dialog can also appear by clicking on any 
node that requires filtering.

To refresh a node

1 Click the Query Links button on the navigation bar (Fig. 66).

2 Click the Enterprise Browser  icon.

The Enterprise Browser tree appears in the details pane.

3 Click on the root node on the left pane to expand the tree.
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Selecting Verbs
The tree expands and displays all the nodes available in the 
enterprise. 

Fig. 70 Using the Shortcut Menu to Refresh a Node

4 Right-click on a container node to display the pop-up menu.

5 Select the Refresh command.

The system retrieves the nodes and adds them to the node that 
was refreshed.

Selecting Verbs Other verbs such as Delete, Start, and Stop services are some of 
the commands that can be available on the pop-up menu. These 
commands are totally dependent on the specific bv-Control product.

To select a verb

1 Click the Query Links button on the navigation bar (Fig. 66).

2 Click the Enterprise Browser  icon.

The Enterprise Browser tree appears in the details pane.

3 Click on the root node on the left pane to expand the tree.

The tree expands and displays all the nodes available in the 
enterprise.

4 Right-click on a container node to display the pop-up menu.
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Selecting Verbs
The commands that appear on the pop-up menu may vary and 
are defined by the selected bv-Control product.

Fig. 71 Selecting a Verb

5 Select the Delete command if you need to delete users, or 
Start or Stop if you need to start or stop services.
7: Enterprise Browser 101

© 2004 BindView Corporation. All Rights Reserved



Selecting Verbs
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8 Scope Manager

In This Chapter Creating a Named Scope .......................................... 104
Managing Named Scopes .......................................... 105
Defining Default Scopes for Users .............................. 109
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Creating a Named Scope
Creating a Named 
Scope

The Scope Manager feature allows you to create and manage 
named scopes across datasources and bv-Control products. 

You can create a named scope with the New Named Scope dialog.

To create a named scope

1 Click the Scope Links button on the navigation bar.

2 Click the Create a Named Scope  icon.

The New Named Scope dialog appears, displaying existing 
named scopes in the Named Scopes tab.

Fig. 72 New Named Scope Dialog

3 Begin adding objects from the Available Scopes list into the 
Selected Scopes list. You can add items from either the 
Datasources tab, the Enterprise tab, or the Named Scopes 
tab. These tabs organize datasources by products installed and 
loaded into the Console.

The scope objects will be saved from the Selected Scopes list 
into the user-specified named scope.

4 Clear the Allow other BindView users to modify this 
selected named scope check box if you don’t want other 
users to make any changes to the named scope you are 
creating. Otherwise, keep the check box selected.

5 Click OK to create the new named scope.
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Managing Named Scopes
The Enter name of new scope message box appears. 

Fig. 73 Enter Name of New Scope Dialog

6 Enter a name for the new named scope and click OK.

The new name will appear in the Named Scope Browser.

Managing Named 
Scopes

You can perform the following scope-related tasks from the Named 
Scope Browser to manage named scopes.

• View a Named Scope
• Modify a Named Scope
• Duplicate a Named Scope
• Delete a Named Scope

By default, only BindView Administrators and the user who created 
a named scope are allowed to modify or delete it. However, if the 
user who created a named scope selects the Allow other 
BindView users to modify this selected named scope option 
when creating a named scope, all users will be able to modify or 
delete that named scope.
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View a Named Scope
View a Named Scope The View feature allows you to view a named scope when you do 
not have the permission to modify or delete it.

To view a named scope

1 Click the Scope Links button on the navigation bar.

2 Click the Named Scope Browser  icon.

The Named Scope Browser window appears in the details 
pane, listing all scopes available. 

Fig. 74 Named Scope Browser

3 Click the View  icon for the named scope you would like to 

view.
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Modify a Named Scope
The Selected Scopes dialog appears.  

Fig. 75 Selected Scopes Dialog 

4 Review the details of the scope and click Close to dismiss the 
dialog.

Modify a Named Scope The Modify feature allows you to make changes to named scopes 
where you are assigned permission to do so by the user who 
created those named scopes.

To modify a named scope

1 Click the Scope Links button on the navigation bar.

2 Click the Named Scope Browser  icon.

The Named Scope Browser window appears in the details 
pane, listing all scopes available (Fig. 74).

3 Click the Modify  icon for the named scope you would like to 

modify.

The Named Scope dialog appears, displaying the scope that 
you selected to modify (Fig. 72).

4 Begin adding scope objects or removing existing ones. 

5 Click OK to save your changes.
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Duplicate a Named Scope
Duplicate a Named 
Scope

The Copy feature allows you to copy an existing named scope and 
save it with a different name.

To duplicate a named scope

1 Click the Scope Links button on the navigation bar.

2 Click the Named Scope Browser  icon.

The Named Scope Browser window appears in the details 
pane, listing all scopes available (Fig. 74).

3 Click the Copy  icon for the named scope you would like to 

duplicate.

The Duplicate As dialog appears. 

Fig. 76 Duplicate As Dialog 

4 Enter a new name for the selected named scope and click OK.

The selected named scope is saved with the new name.

Delete a Named Scope The Delete feature allows you to delete any named scopes where 
you have been assigned the delete permission by the user who 
created those named scopes. 

Caution: When you select to delete a named scope, it will be 
permanently deleted from the Information Server and therefore you 
will not be able to recover it.

To delete a named scope

1 Click the Scope Links button on the navigation bar.

2 Click the Named Scope Browser  icon.

The Named Scope Browser window appears in the details 
pane, listing all scopes available (Fig. 74).

3 Click the Delete  icon for the named scope you want to 

delete. 
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Defining Default Scopes for Users
A Warning message appears. 

4 Click OK to confirm the deletion of the named scope.

The selected scope object is deleted.

Defining Default 
Scopes for Users

You can define default scopes for one or more users in the system 
using the Scope Manager.

To define a default scope for a user

1 Click the Scope Links button on the navigation bar.

2 Click the Assign Default Named Scope  icon.

The Default Named Scope dialog appears, displaying all 
Console users with their default scopes for all datasources in all 
bv-Control products. 

Fig. 77 Default Named Scope Dialog

3 Select a default scope for the named scope you have created 
and click Apply.

4 Click OK to close the Default Named Scope dialog. 

If you have not created any named scopes, you will not be able to 
change default scopes. Also, if more than one named scope is 
assigned to a user, Multiple Scopes will display in the Default 
Scope column for the user.
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Defining Default Scopes for Users
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9 Real-Time Monitoring Services

In This Chapter Alerts..................................................................... 112
Scripts ................................................................... 121
9: Real-Time Monitoring Services 111

© 2004 BindView Corporation. All Rights Reserved



Alerts
Alerts The Web Console uses Alerts to notify the user of certain 
occurrences on the monitored machines. There are seven methods 
of conveying alerts to choose from when specifying a filter to 
retrieve alerts:

• Exchange Mail – Sends an e-mail message through an Exchange 
Mail server.

• SMTP Mail – Sends an e-mail message to an SMTP mail address.
• Pager – Transmits a short message to a pager.
• Application Launch – Instructs the EDBS to run a specific file.
• SNMP – Sends a message to a host, routers, bridges, and hubs 

using Simple Network Management Protocol.
• Net Send Message – Sends a message using Windows Net Send 

commands.
• Console Message – Displays a message on a machine running 

the BindView RMS Console and Information Server. 

To access the Alerts window, you must have the Enable Real-Time 
Monitor Tasks check box selected using the Settings icon and 
then clicking the Real-Time Monitor tab. This way, you will be able 
to view the Real-Time Links button on the navigation bar that will 
give you access to the Alerts Generated icon to open the Alerts 
window.

Viewing Alerts 
Summary

The View Alerts Summary enables you to see a summary of alerts 
generated based on the criteria contained in a filter. The default 
filter is used whenever no filter is selected.

To generate a summary of alerts

1 Click the Real-Time Links button on the navigation bar.

2 Click the Alerts Generated  icon.

The Alerts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Alerts window for the first time when you 
log on.

3 Select an EDBS and click Connect to establish a connection to 
the selected EDBS.

The Alerts window appears in the details pane, defaulting to 
the View Alerts Summary selection.

4 Set the date range, select a machine and a severity level, and 
click Submit. 

The Alert Type, Status, Ticket ID, and Scripts do not apply to 
the Alerts Summary.

The summary appears in the details pane (Fig. 78).
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Viewing Alerts Summary
Fig. 78 Alerts Summary Details Pane

Ticket ID – Identifying number assigned to the alert when it was 
processed by the EDBS.

Severity – One of the seven severity levels assigned to this 
particular alert.

Resource Name – Name of the machine which has caused the 
alert to be generated.

Time Received – Time the alert was generated. This time reflects 
the local time on the machine where the agent is installed.

Script – Name of the script which generated the alert.

Ack. – Allows you to see the status of an alert, whether retrieved as 
acknowledged or unacknowledged. If an alert’s box is checked, the 
alert was retrieved as acknowledged. However, if the check box is 
blank, the alert was retrieved as unacknowledged.

At the top of the details pane, levels of alerts represented by their 
icons are displayed as well as the count number for each severity 
level (Fig. 79). These icons will help you quickly identify which 
alerts need your immediate attention. 

Fig. 79 Severity Levels on the Details Pane
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Viewing Alerts
At the top of the details pane, a pie chart (Fig. 80) shows the pie 
divided into slices representing total severity levels. The size of 
each slice is proportional to the percentage of the total severity 
levels received.

The Java™ Virtual Machine must be installed in order to view the pie 
chart.

The legend below the chart reflects the colors assigned to each 
severity level. 

Fig. 80 Chart of Severity Levels on the Details Pane

Viewing Alerts The View Alerts feature offers you an easy way to select and filter 
events by date, severity, acknowledgment status, machine name 
and script. The Alerts window automatically refreshes to list new 
alerts that have been created.

To view alerts

1 Click the Real-Time Links button on the navigation bar.

2 Click the Alerts Generated  icon.

The Alerts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Alerts window for the first time when you 
log on.

3 Select an EDBS and click Connect to establish a connection to 
the selected EDBS.

The Alerts window appears in the details pane, defaulting to 
the View Alerts Summary selection.

4 Select View Alerts from the Action list box. 

5 Define the filter parameters and click Submit. 
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Viewing Alerts
All alerts will be retrieved and displayed in the details pane 
according to their ticket ID (Fig. 81). 

Fig. 81 View Alerts Details Pane

< > – Allows you to move between previous and next retrieved 
alerts pages.

Ticket ID – Identifying number assigned to the alert when it was 
processed by the EDBS.

Severity – One of the seven severity levels assigned to this 
particular alert.

Resource Name – Name of the machine which has caused the 
alert to be generated.

Time Received – Time the alert was generated. This time reflects 
the local time on the machine where the agent is installed.

Script – Name of the script which generated the alert.

Ack. – Allows you to change the status of an alert to Acknowledged 
by selecting the check box, or Unacknowledged by clearing the 
check box. A blue arrow appears next to the check box that you 
marked so you can differentiate between the alerts that you marked 
and the alerts that were retrieved as acknowledged or 
unacknowledged.

Submit Changes (button) – Saves the status changes you made to 
the alerts.
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Viewing Alert Details
Viewing Alert Details The Alert Detail dialog allows you to view all the details for any 
selected alert. This includes the content of the alert message and 
other pertinent information such as ticket ID, type, severity, 
recipient, script name.

To view alert details

1 Click the Real-Time Links button on the navigation bar.

2 Click the Alerts Generated  icon. 

The Alerts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Alerts window for the first time when you 
log on.

3 Select an EDBS and click Connect to establish a connection to 
the selected EDBS.

The Alerts window appears in the details pane, defaulting to 
the View Alerts Summary selection, and retrieves the last 
alert of each severity that occurred that day.

4 Select View Alerts from the Action list box, specify a filter and 
click Submit.

All alerts will be retrieved and displayed in the details pane 
according to their ticket ID.

5 Click on the alert ticket ID for which you need to view the 
details.
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Viewing Alert Details
The Alert Detail dialog appears, displaying the alert details 
from the EDBS (Fig. 82). 

Fig. 82 Alert Detail Dialog

The Alert Detail dialog can be accessed using either the View 
Alerts Summary or the View Alerts selections.

6 Click Next to view the details for the following alert displayed in 
the list, or click Previous to view the details for the previous 
alert.

7 Click Close to dismiss the dialog.
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Filtering Alerts
Filtering Alerts The drop-down list boxes at the top of the Alerts window allow you 
to define parameters that filter which alerts to display in the details 
pane, based on any combination of the drop-down lists. 

The default filter displays all alerts in the current day, and is used 
whenever no filter is selected.

The Alerts window can be accessed by clicking the Real-Time 
Links button on the navigation bar and then clicking the Alerts 

Generated  icon and connecting to an EDBS. 

Fig. 83 Alerts Filter

To filter alerts

1 From/To – Enter the starting and ending dates for a range of 
time in the fields. You may also select a date from a calendar by 
clicking the drop-down arrow button for that field.

2 Alert Type – Select any of the seven categories of alerts. For 
more information on these categories, see “Alerts” on page 
112.

3 Status – Select the status of alerts to retrieve, whether 
acknowledged or unacknowledged.

4 Machine – Select a monitored machine.

5 Ticket ID – Enter the identifying number assigned to each 
alert.

6 Severity – Select any of the seven alert severity levels.

When specifying a filter, you may need to choose the severity 
level of alerts to be retrieved. The severity levels are triggered 
when certain conditions are met. There are seven severity 
levels represented by the following icons:
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Acknowledging and Unacknowledging Alerts
7 Scripts – Select a script available to the selected EDBS.

8 Action – Select the type of action to retrieve once you set the 
filter parameters.

9 Submit – Click this button to retrieve the appropriate data for 
your selection.

Acknowledging and 
Unacknowledging 
Alerts

You can acknowledge and unacknowledge alerts by specifying a 
filter and selecting the action from the list box. Once the operation 
has been completed successfully, you will receive a confirmation 
message.

You can only acknowledge and unacknowledge alerts on the EDBS 
where you are currently connected.

To acknowledge all alerts

1 Click the Real-Time Links button on the navigation bar.

2 Click the Alerts Generated  icon. 

The Alerts: Select an Event Database Server window 
appears in the details pane (Fig. 6 on page 26). This window 
appears only when you are connecting to the Alerts window for 
the first time after you log on.

3 Enter the credentials and click Connect to establish a 
connection to the selected EDBS.

The Alerts window appears in the details pane, defaulting to 
the View Alerts Summary selection.

4 Select Acknowledge Alerts from the Action list box, specify a 
filter, and click Submit.

You can acknowledge all alerts of all types and severities, or 
you can specify which group of alerts to acknowledge.

The Acknowledge Alerts message appears, confirming that 
all alerts have been successfully acknowledged.

Informational

Normal

Marginal

Minor

Warning

Major

Critical
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Acknowledging and Unacknowledging Alerts
5 Click OK to return to the Alerts window.

To unacknowledge all alerts

1 Click the Real-Time Links button on the navigation bar.

2 Click the Alerts Generated  icon.

The Scripts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Alerts window for the first time after you 
log on.

3 Enter the credentials and click Connect to establish a 
connection to the selected EDBS.

The Alerts window appears in the details pane, defaulting to 
the View Alerts Summary selection.

4 Select Unacknowledge Alerts from the Action list box, 
specify a filter, and click Submit.

You can unacknowledge all alerts of all types and severities, or 
you can specify which group of alerts to unacknowledge.

The Un-acknowledge Alerts message appears, confirming 
that all selected alerts have been successfully unacknowledged.

5 Click OK to return to the Alerts window.
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Scripts
Scripts The Scripts window allows you to view what scripts are assigned to 
a particular managed resource.

To access the Scripts window, you must have the Enable Real-
Time Monitor Tasks check box selected using the Settings icon 
and then clicking the Real-Time Monitor tab. This way, you will be 
able to view the Real-Time Links button on the navigation bar that 
will give you access to the Managed Scripts icon to open the 
Scripts window.

Viewing Assigned 
Scripts

This feature enables you to see all the scripts currently assigned to 
a selected machine.

To view assigned scripts

1 Click the Real-Time Links button on the navigation bar.

2 Click the Managed Scripts  icon. 

The Scripts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Scripts for the first time when you log 
on.

3 Enter the credentials and click Connect to establish a 
connection to the selected EDBS. 
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Viewing Assigned Scripts
The Scripts window appears in the details pane (Fig. 84).

Fig. 84 Scripts Window 

4 Select a managed computer group from the Managed 
Computers drop-down list.

5 From the Select Machine list, select the machine from where 
you want to retrieve assigned scripts.

6 Click Get Assigned Scripts.
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Starting and Stopping Scripts
The scripts assigned to the selected machine appear on the 

right side of the details pane with either a Running  or 

Stopped  status icon (Fig. 85).

Fig. 85 Scripts Window Displaying Scripts Assigned to a 
Computer

Starting and Stopping 
Scripts

To start or stop a script, use the steps in the following sections.

To start a script

1 Click the Real-Time Links button on the navigation bar.

2 Click the Managed Scripts  icon. 

The Scripts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Scripts for the first time when you log 
on.

3 Enter the credentials and click Connect to establish a 
connection to the selected EDBS.

The Scripts window appears in the details pane (Fig. 84).

4 Select a managed computer from the Managed Computers 
drop-down list.

5 Select a machine from the Select Machine list to view the 
corresponding assigned scripts.

6 Click Get Assigned Scripts.
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Starting and Stopping Scripts
The scripts assigned to the machine selected appear on the 

right side of the details pane with either a Running  or 

Stopped  status icon.

7 Select the appropriate check box for the script to start. 

A blue arrow appears next to the check box that you selected 
so that you can differentiate between the scripts that you 
selected and the scripts that were retrieved as running.

8 Click Change State. 

The script's icon changes from a red  standing script to a 

green  running script.

To stop a script

1 Click the Real-Time Links button on the navigation bar.

2 Click the Managed Scripts  icon. 

The Scripts: Select an Event Database Server window 
appears in the details pane. This window appears only if you 
are connecting to the Scripts for the first time when you log 
on.

3 Enter the credentials and click Connect to establish a 
connection to the selected EDBS.

The Scripts window appears in the details pane.

4 Select a managed computer from the Managed Computers 
drop-down list.

5 Select a machine from the Select Machine list to view the 
corresponding assigned scripts.

6 Click Get Assigned Scripts.

The scripts assigned to the machine selected appear on the 

right side of the details pane with either a Running  or 

Stopped  status icon.

7 Select the appropriate check box for the script to stop.

A blue arrow appears next to the check box that you selected 
so that you can differentiate between the scripts that you 
selected and the scripts that were retrieved as standing.

8 Click Change State.

The script's icon changes from a green running script to a red  
standing script.

You can only start/stop scripts on the EDBS where you are currently 
connected.
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10 Uninstalling the Product
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Uninstalling BindView RMS Web Console
Uninstalling 
BindView RMS 
Web Console

This chapter will guide you through the process of uninstalling the 
BindView RMS Web Console.

Uninstalling the BindView RMS Web Console removes all the Web 
Console components from the machine.

Uninstalling the BindView RMS Web Console only removes pre-
configured .bvd files. Uninstalling does not remove user-created 
.bvd files; therefore, any user-created .bvd files must be manually 
deleted.

To uninstall the BindView RMS Web Console

1 Select the Control Panel command from the Settings 
submenu on the Windows Start menu.

The Control Panel window appears. 

Fig. 86 Control Panel

2 Double-click Add/Remove Programs. 
126 BindView RMS Web Console User Guide

© 2004 BindView Corporation. All Rights Reserved



Uninstalling BindView RMS Web Console
The Add/Remove Programs Properties dialog appears. 

Fig. 87 Add/Remove Programs Properties Dialog

3 Select BindView RMS Web Console. 

4 Click Add/Remove. 

The Confirm File Deletion message appears. 

5 Click Yes to completely remove the BindView RMS Web 
Console.
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Uninstalling BindView RMS Web Console
The Remove Programs From Your Computer dialog appears 
(Fig. 88). The unInstallShield will remove the BindView RMS 
Web Console from your computer.

Fig. 88 Remove Programs From Your Computer Dialog

6 Once the uninstall is successfully completed, click OK.

The BindView RMS Web Console is now uninstalled from your 
computer.
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Glossary

ASP Active Server Page, a Web scripting language.

HTML readme 
files

A Hypertext Markup Language file that contains information about 
the software such as installation, overview, and any known issues.

.bvd file User-created or sample BindView file. Types of .bvd files are query 
binder, task list, export style, and report style.

.pdf files Portable Document Format files for electronic distribution and 
printing.

browser A software program for viewing HTML pages on the Internet.

dataset Term often used to describe what appears in a grid. The set of 
values returned after running a Grid item.

data source Group of fields related to resource objects with similar attributes or 
properties.

details pane The right pane of the BindView RMS Web Console that displays the 
contents of the icon selected in the navigation bar.

dialog Term used in the documentation to indicate the dialog boxes 
available to the user interface.

domain A group of computers and devices on a network that are 
administered as a unit with common rules and procedures.

drop-down list A list of available choices that expands when you click the down-
arrow button at the list box.

EDBS Event Database Server. The core of the TrendAlert system through 
which all generated alerts, alert data, and user instructions pass.

filter Allows you to select specific records to be included in the query 
results. You can filter on any combination of alphabetical letters, 
including entire words and phrases to help narrow a scope’s 
definition.

grid Spreadsheet interface format that displays query results.

launch To run or start an application.

navigation bar A horizontal or vertical design element containing buttons or text 
links to various pages within a Web site.

query Questions you ask to gain specific information about resource 
objects in your network.
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query binder A discrete object for storing and managing queries and query-
related information. Query binders can contain a query definition, 
view type settings, and links to historical datasets.

query building Process of selecting resource objects and defining the desired 
information to be returned.

record Horizontal row in a grid that contains information about a node.

root directory In a computer file system that is organized as a hierarchy or tree, 
the root directory is the directory that includes all other directories.

server A computer program that provides services to other computer 
programs in the same or other computers.

SSL data 
encryption

Secured Sockets Layer encryption protocol designed to provide 
users with a secure communication channel.
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descriptor fields, 53
fields, 52
filters, 58
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sorts, 63

alerts
acknowledging, 119
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application launch alert, 112
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view a grid, 93

BindView Information Server. See Information 
Server

C
configuring SSL, 37
connecting to Information Server, 19
console message alert, 112
copying a named scope, 108
creating a named scope, 104
creating a query

adding and removing resource objects, 67
adding descriptor fields, 53

adding custom fields, 55
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adding filters, 58
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adding scopes, 66
adding sorts, 63
managing fields, 57
managing filter terms, 62, 63
managing sort fields, 65
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custom fields
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D
data source, 50
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saving, 83
default scopes

defining, 109
using, 67
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Another Field, 60
Prompt User, 61
Specific, 59

deleting a named scope, 108
deleting jobs, 84
descriptor fields

adding, 53
descriptor selections

modifying, 57
details alert, 116
displaying historical datasets, 77
duplicating a named scope, 108

E
EDBS. See Event Database Server
enabling Real-Time Monitor tasks, 46
Enterprise Browser

filtering a node, 96
refreshing a node, 99
selecting a verb, 100
specifying a range, 98

Event Database Server, 26
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Exchange Mail alert, 112

F
field descriptions

reviewing, 56
fields

adding, 52
filtering, 56
managing, 57
removing, 57

filter terms
grouping, 63
managing, 62
modifying definitions, 62
removing, 62
ungrouping, 63

filters
adding, 58
alerts, 118
fields, 56
nodes, 96

folders
My Items, 73
Pre-Defined, 73
Shared, 72

G
generating a summary of alerts, 112
grid

viewing unsaved datasets, 85
grouping filter terms, 63

H
halting running jobs, 85
historical datasets

displaying, 77
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scripts, 123
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query binders, 75
query completion wizard, 69
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Pre-Defined folder, 73
running a query from, 73
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removing sort fields, 65

Specific value
defining, 59
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saving datasets, 83
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using default scopes, 67
using the query completion wizard, 69

V
verb selection, 100
viewing

alerts, 114
baseline grid, 93
dataset reports, 79
named scopes, 106
scripts, 121
unsaved datasets grid, 85
Index 133

© 2004 BindView Corporation. All Rights Reserved



134 BindView RMS Web Console User Guide

© 2004 BindView Corporation. All Rights Reserved


	BindView RMS® Web Console v8.00
	Information Resources
	About BindView Corporation
	Online Documents
	Using PDF Files
	User Guides
	Release Notes
	Online Help

	Typestyle Conventions
	Alert Statements
	Contacting BindView

	1 Overview
	BindView RMS Suite
	BindView RMS Web Console
	BindView RMS Web Console Architecture
	Selecting a BindView Information Server
	Using the BindView RMS Web Console
	Navigation Bar
	Query Tasks
	Home
	Real-Time Monitoring Tasks

	Selecting an Event Database Server

	2 Installing the BindView RMS Web Console
	System Requirements
	Installing the Product
	Enabling IIS 6 Web Server
	Configuring the Secure Sockets Layer

	3 Settings
	Configuring the Web Console
	Queries
	Real-Time Monitor
	Version Information

	4 Query Services
	Understanding Queries
	Creating a New Query
	Selecting a Data Source
	Adding Fields
	Adding Descriptor Fields
	Managing Fields Added to a Query Definition
	Adding Filters
	Managing Filter Terms
	Adding Sorts
	Managing Sort Fields
	Adding Scopes
	Adding and Removing Resource Objects
	Saving Named Scopes

	Running Queries
	Running Queries from the Query Options Dialog
	Using the Query Completion Wizard

	Query Binders
	Launching a Query
	Launching a Task List
	Modifying a Query
	Accessing a Query Binder
	Displaying Saved Datasets
	Viewing Information About a Query
	Viewing Exported Files


	5 Task Status Monitoring
	Monitoring the Status of Processed Tasks
	Saving Datasets to Query Binders
	Deleting Jobs
	Halting Jobs
	Viewing Unsaved Datasets
	Viewing Task List Summary

	6 Baselining
	Undestanding a Baseline
	Monitoring the Status of Baselined Datasets
	Viewing a Baseline Grid

	7 Enterprise Browser
	Browsing the Enterprise
	Selecting Verbs


	8 Scope Manager
	Creating a Named Scope
	Managing Named Scopes
	View a Named Scope
	Modify a Named Scope
	Duplicate a Named Scope
	Delete a Named Scope

	Defining Default Scopes for Users

	9 Real-Time Monitoring Services
	Alerts
	Viewing Alerts Summary
	Viewing Alerts
	Viewing Alert Details
	Filtering Alerts
	Acknowledging and Unacknowledging Alerts

	Scripts
	Viewing Assigned Scripts
	Starting and Stopping Scripts


	10 Uninstalling the Product
	Uninstalling BindView RMS Web Console
	Glossary

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	P
	Q
	R
	S
	T
	U
	V



